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1. Subject mastering goals 

 

Main goals of mastering "Medical Informatics" are to achieve the aggregate results of education 

in the form of professional competencies necessary for mastering the subsequent academic 

disciplines and in professional activities of specialists and getting students the necessary knowledge 

of the software and hardware structure of a personal computer, the methods of processing, 

analyzing and presenting biomedical data using computer technologies, the basic principles of work 

in the worldwide computer network Internet, the use of the package in applications at the level of a 

qualified user. 

The tasks of studying medical informatics are: obtaining basic computer skills; studying the 

main specialized software packages, mastering the methods of searching, storing, processing and 

analyzing information from various sources and databases, presenting it in the required format with 

the use of information, computer and network technologies; competent use of medical databases; 

the use of acquired knowledge and skills in their professional activities, in carrying out biomedical 

experiments and scientific and technical research. 

 

2. Subject’s place in bachelor MPEP’s structure 

 

The academic discipline refers to the basic part of the C1 block. 

The study of discipline is based on knowledge by students of the following disciplines: Physics, 

Mathematics. 

The main provisions of medical informatics are necessary for the study of disciplines: 

Normal physiology, Pharmacology; Public health and health, Health Economics. 

 

3. Student competences developed as a result of subject (module) mastering 
Studying of the subject is intended to develop elements of the following competences 

according to FSES HE in the given field: 

Codes of 

competences 

Name of  

 competence 

Structural elements of the competence 

(as a result of the development of the discipline 

the student should know, be able and  acquire) 

1 2 3 

GPC-1 

be ready to solve typical 

problems in their professional 

activities using different 

information sources, medical 

terminology, computer 

technologies and complying 

with the demands of 

information security  

Knowledge: the possibilities of using the main 

specialized software packages, modern ways of 

creating and editing graphic files and text 

documentation; existing methods of processing 

and presenting experimental data. 

Skills: independently apply knowledge to study 

specialized software packages, to work with 

various data. 

Working abilities: the skills to work with 

specialized software packages to solve 

professional problems. 

SPC-20 

be ready to analyse and submit 

for public assessment  the 

medical data founded 

onevidence-based medicine 

Knowledge: the basic statistical methods of 

processing medical and biological research. 

Skills: to use information resources, information 

and communication technologies for solving 

problems of professional activity. 

Working abilities: the skills of working with 

information and communication technologies. 
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4. Structure and content of subject (module) MEDICAL INFORMATICS 

4.1. Subject’s (module’s) structure MEDICAL INFORMATICS 

General work load of the subject totals 3 credit units, 108 hours. 
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1.  Theoretical Foundations of Informatics                    

1.1.  Introduction to Medical Informatics. 2 1 2 2                

1.2.  Theoretical bases of computer science. 2 1 2 2                

1.3.  The device and principles of operation 

of a personal computer. 

2 2 2 2                

1.4.  Computer hardware. 2 2 2 2                

1.5.  Computer software. 2 3 2 2                

1.6 Medical information systems 2 3 2 2                

1.7 Medical information systems of a 

basic level 

2 4 2 2                

1.8 Medical information systems of 

federal level 

2 4 2 3                

2.  The main software applications used to 

process, analyze and present biomedical 

data 

                   

2.1.  Operating system Windows. 2                   
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2.1.1 Basic functions of operating systems 2 5 3  3         5      

2.1.2 File system 2 5 3  3  1 1         5   

2.1.3 Working with files and folders 2 6 2  2               

2.1.4 Toolkit Windows. 2 6 3  3  1 1    6        

2.2 Word Processors. 2                   

2.2.1. The purpose and interface of a word 

processor 

2 7 3  3  1 1      7      

2.2.2. Formatting the document 2 7 3  3   1  1

  

           

2.2.3 The operations of copying, moving 

and deleting a piece of text 

2 8 2  2  1 1         8   

2.2.4 The possibilities of a word processor 

for automation of work technology 

2 8 3  3  1 1            

2.2.5 Creation of integrated documents 2    9 3  3  1 1    9 

9 

       

2.2.6 Creating and editing graphic images 2 9 3  3  1 1            

2.3 Table processors. 2                    

2.3.1. Table Processor Interface 2 10 2  2  1 1      10      



5 
 

№ 

 

Subject’s (module’s) sections and 

topics 

 

S
em

es
te

r 

S
em

es
te

r’
s 

w
ee

k
s 

Types of learning, including students’ out-

of-class work and workload 

 (in hours) 

Current progress monitoring types 

(by semester’s weeks) 

Work in class Out-of-class work 

T
o
ta

l 

L
ec

tu
re

 

P
ra

ct
ic

e
 

L
ab

o
ra

to
ry

 w
o
rk

 

T
o
ta

l 

P
re

p
ar

in
g
 f

o
r 

cl
as

s 
w

o
rk

 

P
ap

er
s,

 e
ss

ay
s 

et
c.

 

C
o
u
rs

e 
w

o
rk

 (
p
ro

je
ct

) 

P
re

p
ar

in
g
 f

o
r 

ex
am

s 

In
te

rv
ie

w
 

S
p
o
k
en

 t
es

t 

T
es

t 
m

ar
k
in

g
 

C
h
ec

k
 w

o
rk

 m
ar

k
in

g
 

P
ap

er
 m

ar
k
in

g
 

M
ar

k
in

g
 o

f 
es

sa
y
s 

an
d
 o

th
er

 

cr
ea

ti
v
e 

w
o
rk

s 

C
o
u
rs

e 
w

o
rk

 (
p
ro

je
ct

) 

o
th

er
 

2.3.2. Data stored in spreadsheet cells 2 10 2  2  1 1         10   

2.3.3 New workbook settings 2 11 2  2  1 1            

2.3.4. Automatic change of relative 

references when copying and moving 

formulas 

2 11 3  3  1 1    11        

2.3.5 Editing and formatting charts 2 11 3  3  1 1         11   

2.3.6 Data lists and sorting 2 12 2  2             12   

2.3.7 Data collection 2 12 3  3  1 1            

2.4 Presentation preparation programs. 2                   

2.4.1 The main functionality of the MS 

PowerPoint presentation preparation 

program 

2 13 2  2  1 1      13      

2.4.2. Processing of bitmaps using graphical 

editors 

2 13 3  3  1 1         13   

2.5 Database management systems 2                   

2.5.1 Functionality of DBMS 2 14 2  2    1 1    14        

2.5.2 Creating a single-table database 2 14 2  2  1 1      15      

2.5.3 Forming queries and reports for a 

single-table database 

2 15 3  3  1 1            
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2.5.4 Creating a relational database 

structure 

2 15 3  3  1 1         15   

2.6. Computer telecommunications in 

medicine 

2                   

2.6.1 Working in global networks 2 16 2  2  1 1      16      

2.6.2 Medical applications of computer 

networks 

2 16 2  2  1 1         16   

 Final lesson 2 17 4  4  1 1            

 General workload, in hours   85  68  23 23    Interim attestation 

Type Semester 

Test 2 
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4.2. Subject’s (module’s) contents 
 

Theoretical Foundations of Informatics 

Concept of medical informatics . Brief historical background. 

Design and principles of a personal computer. 

Elements of computer engineering. 

Basic computer equipment. Representation of the data in the computer. 

Classification of computers. Composition of the computer system. 

Computer hardware. 

The basic building blocks of the computer. Basic functional unit of the computer. 

Computer software. 

Software layers. Applied general purpose programs. 

Concept of computer network. Features of the organization of local area networks. 
 

Main software applications used for processing, analysis and presentation of biomedical data. 

System software. 

Operating system (OS) Windows. 

Basic functions of operating systems. File system. The main features of Windows. Toolkit 

Windows. Work with files and folders. 

Application software. 

The word processor. 

The main functionality of word processors. Word MS Word Processor: creating and editing 

documents, formatting a document, presenting information in a tabular form, creating integrated 

documents, creating and editing graphic images. 

The table processor. 

The main functionality of table processors. MS Excel spreadsheet: setting up a new 

workbook; creation and filling of the table with permanent data and formulas; building, editing and 

formatting diagrams; lists and sorting of data; data sampling. 

Computer telecommunications in medicine. 

Fundamentals of computer communications. Work in global networks. Medical applications 

of computer networks. 

Presentation preparation programs. 

Functional capabilities of MS PowerPoint presentation preparation program. Create a 

presentation based on the template. Image processing using the MS Photo Editor. Create a 

presentation using your own graphic images. 

Database management system (DBMS). 

Basic concepts. Functionality of the DBMS. MS Access: creating a single-table database; 

generation of queries and reports for a single-table database; the development of an infologic model 

and the creation of a relational database structure. 
 

5. Education technologies 

In  order  to  implement  an  individual  approach  to  teaching  students  who  carry  out  the 

learning process on their own trajectory within the framework of an individual work plan, the study 

of this discipline  is  based  on  the  following  possibilities:  providing  out-of-class  work  with  

students including in the electronic educational environment using appropriate software equipment, 

distance learning forms , the possibilities of Internet resources, individual consultations, etc. 

Teaching discipline is conducted with the application of the following types of educational 

technologies: 

1) the use of electronic educational resources (assignments for practical classes, 

methodological materials) in preparation for practical classes; 

Topic 1.1-1.8; 2.1-2.6. 

2) the use of computer technology in all practical exercises; 

Topic 1.1-1.8; 2.1-2.6. 

3) test knowledge control; 

Topic 1.1-1.8; 2.1-2.6. 

4) individual consultations of the teacher when performing assignments for practical classes 
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and group consultations before testing for each section of the discipline; 

Topic 1.1-1.8; 2.1-2.6. 

5) individual training of excellent students on the basis of the formation of an individual 

program for discipline, taking into account the interests of students; 

Topic 1.1-1.8; 2.1-2.6. 

6) participation of students in scientific research; 

Topic 1.1-1.8; 2.1-2.6. 

 

5.1 Active Learning Methods 

• "Lecture-visualization" is a visual form of presentation of a lecture material by means of TCO or 

audio-video equipment; 

Theme 2.1 - Windows operating system; 

Topic 2.2 - Word Processors; 

Topic 2.3 - Table processors; 

Topic 2.4 - Presentation preparation programs; 

Topic 2.5 - Database management systems; 

Topic 2.6 - Computer telecommunications in medicine. 

• Case-study method or method of concrete situations (from English case - case, situation) - the 

method of active problem-situational analysis, based on learning by solving specific tasks-

situations; 

Theme 2.1 - Windows operating system; 

Topic 2.2 - Word Processors; 

Topic 2.3 - Table processors; 

Topic 2.4 - Presentation preparation programs; 

Topic 2.5 - Database management systems; 

Topic 2.6 - Computer telecommunications in medicine. 

• The decision of situational / program tasks allows to reveal a level of knowledge of a material and 

develops at students skills of use of knowledge in a concrete situation; 

Theme 2.1 - Windows operating system; 

Topic 2.2 - Word Processors; 

Topic 2.3 - Table processors; 

Topic 2.4 - Presentation preparation programs; 

Topic 2.5 - Database management systems; 

Topic 2.6 - Computer telecommunications in medicine. 
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6. Educational and methodological support of students’ out-of-class work. Assessment means for current progress monitoring, interim attestation of 

subject mastering results 

Control of the discipline development is carried out according to the methodology and schedule of the rating assessment of students' knowledge 

(instruction I.151.1.02 - 2009), approved by the head of the department. 

The current control of students' progress is conducted by the teacher conducting the lesson, in the form of monitoring the timeliness and correctness 

of the student's typical tasks at each practical lesson in discipline, computer testing and student protection of the report. 

A graduate student attestation is conducted after the completion of the next section of the discipline in the following forms: 

computer testing. 

Control of the development of the academic discipline on the basis of the semester results is conducted by the teacher in the following forms: 

Test. 

6.1. Plan of students' individual work 

№  Topic Out-of-class 

work type 

Task Recommended 

literature 

Amounto

fhours 

1 Operating system Windows 

 

Preparation for 

lecture classes 

To study the material of the methodical manual 

Answer test questions 

Basic 1, 2 Add. 1 2 

Complete the assignment for practical work 

2 Word Processors Preparation for 

lecture classes 

To study the material of the methodical manual 

Answer test questions 

Basic 1, 2 Add. 1 6 

Complete the assignment for practical work 

3 Table processors 

 

Preparation for 

lecture classes 

To study the material of the methodical manual 

Answer test questions 

Basic 1, 2 Add. 1 6 

Complete the assignment for practical work 

4 Presentation preparation 

programs 

Preparation for 

lecture classes 

To study the material of the methodical manual 

Answer test questions 

Basic 1, 2 Add. 1 2 

Complete the assignment for practical work 

5 

Database management system 

 

Preparation for 

lecture classes 

To study the material of the methodical manual 

Answer test questions 

Basic 1, 2 Add. 1 4 

Complete the assignment for practical work 

6 Computer telecommunications 

in medicine 

Preparation for 

lecture classes 

Complete the assignment for practical work Basic 1, 2 Add. 1 2 

Complete the assignment for practical work 
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                        6.2. Instructional guide lines on students’ out-of-class work organization 

 

Preparation for lecture classes 

1. Read the theory from the guidelines, lectures, textbooks; 

2. Answer the control questions in the guidelines for practical exercises; 

3. To issue a report on the previous practical work. 
 

                        6.3. Materials to carry out current monitoring and interim attestation of 

students’ knowledge 

 

Control development of competencies 

№ type of control Controlled section 

Competence, the 

components of which 

are controlled 

1.  Checking the execution of a 

practical task 

Section 2 GPC-1, SPC-20 

2.  Testing Section 1,2 GPC-1, SPC-20 

3.  Interviewing Section 1,2 GPC-1, SPC-20 

 

Demonstrative test variant 

1. The function of the operating system is ... 

A. Ensuring the implementation of system and application programs 

B. Support of computer peripherals 

B. File system support 

D. Processing of programs 

2. What is displayed on the screen immediately after the Windows operating system is 

booted? 

A. System menu 

B. Control panel 

B. The taskbar 

G. Working table 

3. The document window in Windows OS contains: 

A. Status bar 

B. Workspace 

B. Vertical and horizontal scroll bar 

D. Toolbar 

D. System menu button 

4. How does the scale of the MS Word document display affect the printing of a document? 

A. Increases font size when printing 

B. Influences have no effect 

B. Increases the size of the images when printing 

D. Requires page size changes 

5. In what way can you ensure that the last line of MS Word text does not go to the next page, 

and all the text would be placed on one page? 

A. Select File> Preview> Adjust Pages 

B. Decrease font size throughout the document 

B. Select the command Format> Paragraph> Position on page> Disable fading lines 

D. Select the command Format> Paragraph> Position on the page, clear the check box Do not 

automatically wrap words 

6. Filtering in MS Excel can be performed using: 

A. The composite filter 

B. autofilter 

B. simple filter 

D. Extended Filter 
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7. MS Excel charts are built on the basis of: 

A. Active MS Excel Workbook 

B. data tables 

B. selected cells of the table 

G. Worksheet worksheet MS Excel 

8. A spreadsheet cell is defined: 

A. Column names 

B. the intersection of rows and columns 

B. row numbers 

User-defined name 

9. Mathematical functions of table processors are used for: 

A. constructing logical expressions 

B. Determining the amount of monthly payments to repay the loan, calculating depreciation rates 

The calculus of logarithms, trigonometric functions 

D. Calculation of the mean, minimum, maximum 

10. Which of the following are the objects in the spreadsheet? 

A. Chart 

B. Block of cells 

B. The string 

D. Request 

D. Column 

E. Registration number 

J. Book 

11. The ordering of values for a range of cells is called: 

A. Formatting; 

B. filtration; 

V. grouping; 

G. sorting. 

12. In the presentation you can use: 

A. digitized photos; 

B. soundtrack; 

B. documents prepared in other programs; 

D. All of the above. 

13. The information revolution is: 

A. Transformation of public relations because of cardinal changes in the sphere of information 

processing 

B. the possibility of a person to receive in full the information necessary for his life and professional 

activity 

V. radical transformation of the dominant technological order in society 

G. military actions for information 

D. change in the ways of forming and using the aggregate intellectual potential of society 

14. The information picture of the world is: 

A. The most common form of reflection of physical reality, performing a generalizing, 

systematizing and worldview function 

B. developed by society and intended for general consumption way of reproduction of the human 

environment 

B. a generalized image of the movement of social matter 

G. a set of information that allows you to adequately perceive the surrounding world and exist in it 

D. stable theoretical education for explaining the phenomena of the surrounding world on the basis 

of fundamental physical ideas. 

15. Third Generation Computer: 

A. had as an element base electronic tubes; characterized by low speed, low reliability; programmed 

in machine codes 

B. had as an element base semiconductor elements; programmed using algorithmic languages 
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V. had integrated circuits as an element base; were able to access from remote terminals; 

G. had as a base element large integrated circuits, microprocessors; relatively cheap; 

D. had as an element base the extremely large integrated circuits; were able to model human 

intelligence. 

16. In what year was the first national computer created - MESM under the leadership of SA. 

Lebedev? 

A. In the year 1950 

B. In 1959 year 

В. In 1961 year 

G. In 1991 

17. What quality of information is associated with its semantic content (semantics) and pragmatics? 

A. Sufficiency 

B. Adequacy 

B. Accessibility 

D. Accuracy 

D. Credibility 

18. What is the program? 

A. An ordered computing system 

B. An ordered sequence of commands for the computer 

B. An orderly sequence of instructions for the computer 

D. All of the above 

19. What is the non-position number system? 

A. Set of symbols and rules for the designation and naming of numbers 

B. A system in which each quantitative equivalent - the value of each symbol - does not depend on 

its position in the code number 

B. A system in which a quantitative equivalent, the value of a symbol depends on its place 

(position) in the code number 

D. There is no correct answer 

20. What is computer technology? 

A. It is an electronic device that works in the program and is designed to automate the creation, 

storage, processing and transport of data. 

B. A set of devices designed for automatic or automated processing of data. 

B. A specific set of interacting devices and programs, designed to maintain one workplace or 

section 

D. There is no correct answer 

21. What determines the maximum number of rows and columns? 

A. From the features of the program used. 

B. From the amount of computer memory. 

V. Does not depend on anything. 

D. There is no correct answer. 

20. Which elements of the application window are specific (not used in other applications) for 

Excel? 

A. Toolbar. 

B. The row of formulas. 

B. The status line. 

D. The menu bar. 

D. Area of sheet management. 

E. Scroll bars. 

22. In the list of functions, indicate the functions related to the statistical category: 

A. MIN (), MAX (), AVERAGE (). 

B. MIN (), MAX (), SUM (). 

B. SUM (), MAX (), IF (). 

G. MAX (), MIN (), IF (). 

23. Which of the following formatting options can be configured in the Font dialog box? 
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A. Select the language used. 

B. The color of the symbols. 

B. The distance between the symbols. 

G. Inscription. 

24. How can I start the numbering of MS Word document pages from the 13th? 

A. You can start numbering from any page number, for this, in the first line of the first printed 

sheet, you need to dial the desired number and then correctly align it. 

B. It is impossible, the numbering of pages should begin with the number 1. 

Q. You can do this by using the Insert → Page Numbers ... command. 

D. You can, for this you need to use the command Format → Page numbers ... 

25. With what help do you set the boundaries of paragraphs? 

A. Using indentation markers on the coordinate line. 

B. Using the appropriate menu commands. 

Q. All the answers are correct. 

26 What are the main data types supported by the MS Excel spreadsheet: 

A. Text, numeric; 

B. formulas, text, numeric; 

V. numerical, formulas, date-time, text; 

D. Text, numeric, percentages, formulas, functions 

27. What is the result of computing an arithmetic formula? 

A. Cell. 

B. Cell address. 

B. The number. 

D. There is no correct answer. 

28. What coding is based on data representation by a sequence of two characters 0 and 1? 

A. Binary coding 

B. Tertiary coding 

Q. There is no correct answer 

D. Positional coding 

29. What is Kbyte? 

A. 1024 bytes 

B. 124 bytes 

V. 2
24

 bytes 

G. 2
10

 bytes 

30. What are browsers? 

A. Software designed for viewing electronic documents executed in HTML format 

B. Software designed for viewing electronic documents in txt format 

B. Software for editing electronic documents in HTML format 

D. There is no correct answer 

31. Where did the term "computer science" come: 

A. France 

B. America 

W. England 

G. Germany 

D. Spain 

 

Criteria for evaluating the test 

 

"Excellent" ("5") - 91% and more correct answers to test tasks. 

"Good" ("4") - 81-90% of correct answers to test tasks. 

"Satisfactory" ("3") - 71-80% of correct answers to test tasks. 

"Poor" ( "2") - 70% or less of correct answers to test questions. 

 

Demonstrative questions for control tasks 
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Theoretical Foundations of Informatics 

1. The concept of medical informatics. 

2. Basic means of computer technology. 

3. Classification of computers. 

4. The main functional devices of the computer. 

5. General application programs. 

 

The main software applications used to process, analyze and present biomedical data 

1. Operating system Windows. 

2. Compression of information. Functionality of archiver programs. 

3. Computer malicious programs, methods and means to combat them. 

4. Purpose and interface of the word processor. 

5. The concept of a database and a database management system. 

 

Demonstrative practical tasks 

 

Word Processors 

1. Download the Word word processor; 

2. Set the pagination mode of the document on the screen; 

3. Set the main parameters (font type and size, text alignment method), which will be set by default 

when entering text; 

4. Type the following text without pressing <Enter>: 

Ladies and gentlemen! Visit the website "Medical information resources of the Penza region". Here 

you will find information about the healthcare system of the Penza region, the official website of 

the Medical Institute of Penza State University, a medical library containing electronic textbooks, 

scientific articles, books, thematic reviews of literature, conference proceedings, educational 

literature and much more. Our address in the Internet: http://medic.pnzgu.ru. 

5. Save the typed text in the file named Text1. Note the difference between the Save As ... and the 

Save command; 

6. Close the document; 

7. Open the document; 

8. Close the document; 

9. Learn how to leave the Word environment. 

 

Table processors 

As an example of a table, an examination sheet is considered (Figure 9). For each group, 

generic lists are created that contain the lists of students (last name, first name, patronymic, number 

of the record book) and their grades in the exam. 

In this task, it is required to prepare an electronic examination sheet for each group based on 

the table created in work 1 (see Figure 9). 

In any table, you can always select at least two structural parts -name and its cap. 

The table name is entered into any cell and is formatted with fonts. 

Formation of the table header is recommended in the next sequences: 

• Define the way to align the name of the graph (for large texts 

it is necessary to provide word wrapping); 

• in each cell of one line enter the names of the table graphs; 

• set the width of each column of the table. 

After completing the design of the table header, enter in the table the permanent 

data: 

• the names of students and their grades in a particular discipline; 

• headers at the bottom of the table for totals that will be counted later when task 3 is completed. 

After the completion of the work on filling the statement with permanent data 

remember it as a workbook. 

For a better understanding of the technology work in Excel, do the training. To do this, 
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perform all the operations indicated in the table above. 

 
EXAMINATION LIST 

Group № _____ Discipline ________________________________ 

№  The Surname, a name, a patronymic № Record book 

assessment  

Assessment The Signature of 

the examiner 

     

     

     

     

  

Computer telecommunications in medicine 
Configuring the browser: 

1. Read the contents of the browser menu items; 

2. Learn to open the browser window to the full screen and minimize it to its previous size; 

3. Learn how to configure the browser home page; 

4. Learn how to configure temporary Internet files. 

 

 

Presentation preparation programs 

1. Create a presentation based on one of the Power Point template; 

2. Replace the standard text in the template slides with your text; 

3. Select the modes for changing (transitioning) slides on the screen by setting: 

• slide transition sound effects; 

• animation effects of both the slides themselves and their objects; 

• time in automatic mode. 

4. Save the slide film in your working folder in two formats - presentations and demonstrations; 

5. Launch the slideshow in presentation mode and adjust slideshow time intervals, animation and 

sound effects; 

6. Run the slideshow in demo mode. 
 

Database management systems 

Develop a logical model of a relational database (DB) in the subject area in accordance with 

an embodiment consisting of three related tables containing at least five different types of fields 

each. Developed on the basis of the logical model to create a database using the database 

management system MS Access, comprising: 

- Data entry form for each table in the database;  

- Two simple query on data select;  

- At least three reports with grouping data;  

- Switchboard menu containing buttons for opening all elements created database (tables, 

queries, reports). 

For one of the database tables, set the condition for the field value and the default field value, 

fill in the database tables (enter at least 10 entries into each table). Perform operations of 

searching, sorting and filtering data in the fields of the table and using a form. 

Examples of data for building databases should be offered independently from the subject area 

issued by the teacher. 

 

Criteria for assessing practical skills 

10 points - 91-100% of correctly performed tasks. 

9 points - 81-90% of correctly performed tasks. 

8 points - 71-80% of correctly performed tasks. 

7 points - 61-70% of correctly performed tasks. 

0 points - 60% or less correctly performed tasks. 

 

Demonstrative test questions 
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Theoretical Foundations of Informatics 

1. The concept of medical informatics. 

2. Basic means of computer technology. 

3. Classification of computers. 

4. The main functional devices of the computer. 

5. General application programs. 

 

The main software applications used to process, analyze and present biomedical data 

1. Operating system Windows. 

2. Compression of information. Functionality of archiver programs. 

3. Computer malicious programs, methods and means to combat them. 

4. Purpose and interface of the word processor. 

5. The concept of a database and a database management system. 

 

Criteria for evaluating answers to theoretical questions 

6 points the student deeply understands the material he has passed, answers clearly and 

comprehensively, knows how to evaluate the facts, independently argues, is distinguished 

by the ability to justify the conclusions and explain them in a logical sequence. 

5 points the student deeply understands the material he has covered, answers clearly and 

comprehensively, knows how to evaluate the facts, independently argues, is distinguished 

by the ability to substantiate the conclusions and explain them in a logical sequence, but 

allows for some inaccuracies and errors of a general nature. 

4 points the student understands the material well, but can not theoretically substantiate some 

conclusions. 

3 points in the student's answer there are significant shortcomings, the material is partially 

covered, mistakes are allowed in the reasoning. 

2 points The student's answer is correct only partially, serious mistakes are made when explaining 

the material. 

1 point the student has a general idea of the topic, but does not know how to substantiate his 

thoughts logically or has only a partial idea of the topic. 

0 points no answer. 

 

• "credit" is set for the student if the total amount of the rating scores is 60-100; 

• "not credit" is given to the student if the total score is less than 60. 

 

7. Educational, methodological and informationalmeans provided for 

subject (module) MEDICAL INFORMATICS 

 

а) ) basicliterature: 

1. Glandon, Gerald L.-Slovensky, Donna J.-Smaltz, Detlev H.. Information Systems for 

Healthcare Management – Health Administration Press, 2014. – www.bibliocomplectator.ru 

2. Hasman, Arie-Mantas, J.. Informatics, Management and Technology in Healthcare– IOS 

Press, 2013. – www.bibliocomplectator.ru 

b) additionalliterature: 

1. Brown, Gordon D.-Pasupathy, Kalyan S.-Patrick, Timothy B. Health Informatics– Health 

Administration Press, 2012. – www.bibliocomplectator.ru 

с) Online resources 

1. The licensed version of the Operating System Windows 7 

2. The licensed version of Kaspersky Anti-Virus 

3. Freely distributed Open Office application package. 

4. Electronic library system - www.bibliocomplectator.ru 

 

 

 

http://www.bibliocomplectator.ru/
http://www.bibliocomplectator.ru/
http://www.bibliocomplectator.ru/
http://www.bibliocomplectator.ru/
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8. Material and technical means provided for  

subject (module) MEDICAL INFORMATICS 

 

№  

 

Name of special premises and premises for 

independent work 

The equipment of special rooms and 

premises for independent work 

1.  Audience 10-106, 10th building Personal computers, tables, chairs 
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